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Welcome to Amazon Trail 11

from Mike Palmquist, Producer, Amazon Trail 11

In 1993, I was asked to begin designing Amazon Trail by traveling down the
Amazon River from Iquitos, Peru, to Tabatinga, Brazil. It gave me a once-in-a-
lifetime chance to experience firsthand the Amazon River and the Amazonian
rainforest.

Now, I grew up in Minnesota — home to the headwaters of another great river, the
Mississippi. I thought I knew all about big rivers! But living near the Mississippi
gave me no preparation for what I was to experience.

What I found out from visiting the Amazon and then developing Amazon Trail is
that there is no way to capture on a computer disk more than a small fraction of
how complex, how amazing, how beautiful, and how mysterious the Amazon is.

For one thing, we
can't bring the
smells of the
marketplace or the
wet rainforest floor
through the
CD-ROM to your
home. For another,
try as we might, we
can't really bring
you all the strange
and surprising

- : sounds of the
A convenience store on the Amazon River near lquitos rainforest at night!
And, there is no
way to show how overwhelming the darkness feels when night falls on your boat
and you're miles from any village! Finally, there’s no way to bring the rich tastes
of Amazon fish and fruit to your table through the keyboard, the mouse, or the
modem port!
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But we can bring you a rich and compelling rainforest adventure. We can take you
hundreds of miles up the river in a matter of seconds. We can take you back in time
hundreds of years. We can introduce you to dozens of interesting characters. We
can show you a hundred Amazon species that you’d be lucky to see even if you
explored the rainforest for a whole year. You'll be able to catch fish and frogs! Spot
night monkeys! Rescue Teddy Roosevelt! Guide your canoe to hidden villages!
And do it all in the safety of your own imagination.

Someday, I hope you'll have the chance to visit the Amazon yourself! Then, you'll
be able to help me put together a new Amazon Trail. Who knows? By then, maybe
we'll have figured out how to put smells and tastes on a computer disk!

A Special Note to Parents

I think there are three big things that a learning adventure like Amazon Trail II
can teach kids. First, Amazon Trail Il encourages and rewards exploration.
Second, it puts the control of content (how much, how fast, and what order)
directly in the hands of kids. Third, the program contains an amazing amount of
information about the science and history of the Amazon rainforest. If kids come to
believe that exploration is fun and rewarding and that they are in control of what
they learn, they are likely to become good life-long learners.

Amazon Trail Il encourages and rewards exploration. In Amazon Trail II,
you canoe up the Amazon River. You need to manage your supplies; meet, talk,
and trade with people; read maps; and decide how much to eat, when to rest, and
how fast to paddle. You also decide when to explore the rainforest and how long to
stay. You might spot one of 100 different species. If you can identify it, you get to
add a photo to your photo album. Rewarding exploration encourages kids to go
further ... look around the corner ... take another step.

In Amazon Trail 11, kids control the educational content. Kids decide which
activities to do. They decide which people they want to talk to. They decide if they
want to help a scientist or naturalist with an activity. Inside Amazon Trail II
there are six learning games where kids learn the origins of commodities like coffee,
rice, and chocolate; locate the major rivers of the world; and identify birds, bugs,
and fish. And, there are over 50 people to talk to! Some characters tell Amazonian
folklore; some give insight and perspective into the rainforest; others present
opposing points of view. It's an open-ended exploration of the Amazon rainforest
... but all of a child’s activities are rewarded with “jewels” on the Jaguar's shield.

2 Amazon Trail 11



A Y N e & £

Amazon Trail II has terrific content in it, too! There are 100 species of
Amazon creatures to photograph and then identify with the help of the on-line
quidebook. Kids can help a scientist or naturalist identify new species of tropical
fish, insects, and birds using the same processes of observation that real scientists
use.

The lessons we have
constructed here are
discovered amidst
the excitement of
the game. Theyre
not lessons of facts
about the average
rainfall in the
Amazon Basin, or
the number of species
in the rainforest
canopy, or when
“so-and-so” explored
the Amazon River.
They're lessons about places worth exploring and how complex and rich these
places are.

In Amazonia, nearly everyone travels by boat

If, after playing Amazon Trail 11, kids remember the name of a fish or a bird or
plant, that's great. But weve won a greater victory if the game inspires kids to go
to the library and check out a book about the Amazon. Or if they take the time to
talk to an adult or older brother or sister about rainforests. Or if they turn off the
computer and go outside to look for insects. And we've won the greatest victory if,
after playing Amazon Trail II, kids say to themselves, “Someday, I've got to
explore the real Amazon River!”

1 hope you take the time to explore this program with your child! Happy

adventures!

Amazon Trail 11 3
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Getting Started

Installation and Start-up

You may need to restart your computer after you install the Amazon Trail®
II software program. It's a good idea to quit all open applications before
you start installing.

* To do a basic installation, follow the instructions that appear on the
back of the little document inside the cover of the CD-ROM case.

To do a custom installation, refer to the README file on the
CD-ROM disk. A custom installation allows you to decide which
files to install.

e To start Amazon Trail II, make sure the CD-ROM is in the drive. Then
double-click on the Amazon Trail Il icon that is on your hard disk.

Amazon Trail II has three levels of difficulty. You'll decide which level to
choose when you start the game. As a general rule, we suggest that
younger kids start with the easy level. Older kids—you’re on your own!

Program Settings

The Options menu has several commands to customize Amazon Trail I1.

e Hide Desktop blacks out or displays the part of your screen that is
not taken up by Amazon Trail 11.

* Reset High Score List lets you delete the names on the high score
list. As you play Amazon Trail II, points are awarded for many things,
including what you do when you talk to people, how healthy you
stay, and how well you manage your supplies. If you score enough
points, you can enter your name on the high score list!

* River Graphics provides three styles of artwork for the river travel
portion of the game. The program is initially set up to display
“fancy” graphics. If you have a not-so-powerful computer, you may
want to try the “basic” or “normal” graphics.

* Show Dialog turns on/ off the textual display of characters’ dialog.
You will encounter lots of people as you travel up the river. The
people talk, of course, and you can hear them through your
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computer’s speakers. You can also see the dialog on the screen, kind
of like subtitles in a foreign movie. Turning on both the sound and
the dialog display can help kids become better readers.

e Show Fishing Meter turns on/off a display that shows how hard
you are throwing a harpoon. You may want to turn off the display
after you've gone fishing a few times.

e Show Labels turns on/off the display of labels for buttons. Many
activities in Amazon Trail II are started by pressing on a button. Each
button has a picture that suggests what will happen when you click
on it. The labels appear whenever you point at a button. After you've
gotten familiar with the buttons, you may want to turn off the labels.

¢ Sound On turns on/off the program’s sound effects, music, and
character dialog.

Help

We've tried to design Amazon Trail II so you can use it without having to
read instructions. But just in case, we've provided an online “Help” file.
Choose the Help Topics command from the Help menu.

Saving and Loading Games

To save a game in progress, choose the Save command or the Save As
command from the File menu. You can save a game only when you are
traveling on the river.

There are several good reasons to save your game frequently. First, you

protect yourself against an unexpected computer breakdown. Second, you
may not be able to finish a game at one sitting. If you save your game, you
can restart it at the point where you left off. Third, you never know when
you might succumb to snail fever or get captured by conquistadors! If you
have saved your game, you can restart it at a point before disaster struck.

Here’s a good way to save: Use the Save As command. Save a game
whenever you leave a landmark, and type a new name for each saved
game. For example, when you leave the Xingu River, save your game
under the name “Xingu.”

You can load a saved game from the program’s title screen.

Amazon Trail I1 5
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Meet Your Guides

Before you head up the Amazon River, you'll need to choose a guide. It's
an important choice. Each guide has a special skill that may help you on
your journey. So you may want to take a few moments now to hear from
each guide.

Ola! Hey, there! I'm Joao! When you get to
Belém, you should choose me to be your guide.
I'm the strongest paddler in the whole Amazon
Valley! Let me tell you about traveling on the
river. If you were really on the river, you
wouldn’t believe how wide it is. In some places,
it’s more than 30 miles across! And the Amazon
Basin is big—really big. It's almost as big as the
whole United States, not including Alaska. And
the amount of water is unbelievable. The Amazon contains almost
one-fifth of all the river water in the world!

In Amazon Trail I, you won’t really get a sense of how big the river really
is. But you will have to watch out for submerged logs and sandbars. Be
careful! I don’t want to capsize the canoe and lose our supplies!

Hi! I'm Rosa. You shouldn’t choose Joao to be
your guide—he’s no good at fishing! You should
choose me. I know where to find the most fish! If
you were really on the Amazon, you wouldn’t
believe how many kinds of fish there are—over
2,000 species! More than in the entire Atlantic
Ocean! People catch fish a lot of different ways.
Some folks use fishing line and lures. Others use
harpoons, nets, or traps. Some Indians use bows

and arrows; others make a potion from the barbasco plant that paralyzes
fish.

In Amazon Trail 11, you’ll need to fish if you want to eat! You'll be using a
harpoon. The dark-colored fish are near the surface; you won’t have to
throw very hard to hit them. The lighter-colored fish are near the bottom
of the river. You'll need a strong throw to hit them!

6 Amazon Trail IT



Hello! My name is Miguel. I think you should
choose me to be your guide. I'm not a good
paddler like Joao or a good angler like Rosa.
But, I'm a student at medical school. I'm going
to be a doctor. I can help you stay healthy! And
that’s really important. In a tropical climate
like the Amazon, there’s all kinds of nasty
diseases. Like malaria. And dysentery. And
even snail fever!

X o £ L

In Amazon Trail I, you might “get” one of these diseases. If you do, you
can read about them in your guidebook and learn how to treat them.

Ola! Hello! My name is Elena. I'm the best one
to be your guide. That Miguel, he has no idea
where he’s going! I do! With me as your
guide, you'll be sure to get to your destination!
And I don’t mind how long it takes to get
there. We can stop and explore the rainforest
as much as you like. In the real Amazon
rainforest, it's very difficult to see animals,
especially ones that live in the upper canopy.
You're much more likely to hear animals than to see them.

In Amazon Trail 11, you'll
want to check your map
often to make sure we're
still headed for
Vilcabamba. Along the
way, I think we should
stop and explore the
rainforest at least once
between every landmark.
There are all kinds of
habitats to explore: the
rainforest floor ... the A marsh scene from Amazon Trail Il
canopy ... a flooded

forest ... even a marsh! Sometimes, we'll visit these areas during the day.
Other times, it will be night and you'll have to use your flashlight!

Amazon Trail I1 7
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Learning More About the Amazon

Recommended Reading

Cool Books for Younger Kids

Baker, Lucy. Life in the Rainforests: Animals, People, Plants. Franklin Watts,
1990. A reference book that addresses a number of rainforest topics.

Baptista, Lynne Hardie. Discover Rain Forests. Publications International,
Ltd., 1992. A large, colorful book that introduces rainforest ecology.

Cherry, Lynne. The Great Kapok Tree. Gulliver Books, Harcourt Brace
Jovanovich, 1990. An illustrated storybook that is considered a modern
classic for younger readers.

Dorros, Arthur. Rain Forest Secrets. Scholastic, Inc., 1990. An illustrated
introduction to rainforest concepts for younger readers.

Flora. Feathers Like a Rainbow: An Amazon Indian Tale. Harper Row, 1989. An
enchanting retelling of an Amazonian myth.

Forsyth, Adrian. Journey Through a Tropical Jungle. Simon and Schuster,
1988. Description of a scientist’s expedition in the rainforest of Costa Rica.

George, Jean Craighead. One Day in the Tropical Rain Forest. Simon and
Schuster, 1988. Life in the rainforest as seen in one 24-hour period.

Goodman, Billy. The Rain Forest. Tern Enterprise, Inc., 1991. An
introduction to the animals, plants, and people who depend on rainforests.

Greenaway, Theresa. Eyewitness Books: Jungle. Alfred A. Knopf, 1994.
Excellent text and photographs.

Lessem, Don. Inside the Amazing Amazon. Crown Publishers, 1995. Fold-out
illustrations showing what lives in the different layers of the forest.

Sterry, Paul, and Michael H. Robinson. Rain Forest Nature Search. Victoria
House Publishing, 1992. A copiously illustrated activity book.

Taylor, Barbara. Rainforest. A Dorling Kindersley—Look Closer Book,
1992. A colorful overview.

Willow, Diane. At Home in the Rain Forest. Charlesbridge, 1991. A brief
introduction, with color illustrations.

Yolen, Jane. Welcome to the Green House. G. P. Putnam’s Sons, 1993. An
elementary picture book. Beautiful illustrations by Laura Regan.
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Books for Older Kids and Adults

All of these books (and many, many more) were used in doing research for
Amazon Trail II.

Cowell, Adrian. The Tribe That Hides from Man. Stein and Day, 1974. An
account of the work of the Villas Boas brothers and their attempts to
contact the Kreen Akrore. Cowell has two other excellent books: The Heart
of the Forest (Alfred A. Knopf, 1961) and The Decade of Destruction (Henry
Holt and Company, 1990).

Draffen, Andrew, and Robert Strauss and Deanna Swaney. Brazil: A Travel
Survival Kit. Lonely Plant Publications, 1992. A good companion if you're
planning a trip to Brazil.

Ereira, Alan. The Elder Brothers. Alfred A. Knopf, 1992. The story of how a
British Broadcasting Corporation film crew met with the Kogi nation of
Colombia and relayed the Kogi’s message to the world. The inspiration
behind the development of the story in Amazon Trail 11.

Eu, Geoffrey, ed. Amazon Wildlife. APA Publications, 1992. An overview of
Amazonia. Heavily illustrated. Includes information for tourists.

Goodman, Edward ]. The Explorers of South America. University of
Oklahoma Press, 1992. Stories of everyone from Francisco de Orellana to
Gene Savoy (the discoverer of Vilcabamba).

Goulding, Michael. Amazon: The Flooded Forest. Sterling Publishing, 1990.
Describes the phenomenon of flooded forests; includes detailed
information on the fish and other animals that live in this ecosystem.
Gheerbrant, Alain. The Amazon: Past, Present, and Future. Harry N. Abrams,
Inc., 1992. A nicely illustrated historical overview.

Hecht, Susanna, and Alexander Cockburn. The Fate of the Forest: Developers,
Destroyers, and Defenders of the Amazon. Harper Collins Publishers, 1990. An
account of what's happened from the sixteenth century to the present.

Kane, Joe. Savages. Knopf, 1995. The story of the Huaorani Indians’
attempts to protect their land from oil development.

Kricher, John. A Neotropical Companion. Princeton University Press, 1989.
The natural history of tropical rainforests in Central and South America.

MclIntyre, Loren. Amazonia. Sierra Club Books, 1991. A blend of human
history, natural history, and stunning photography.

Amazon Trail 11 9
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Medina, José Toribio. The Discovery of the Amazon. Dover Publications,
1988. A description of Orellana’s voyage. Includes the complete text of
Friar Carvajal’s journal.

Minta, Stephen. Aguirre. Henry Holt and Company, 1993. A travelogue /
history that retraces the steps and recounts the misadventures of Lope de
Aguirre.

Sterling, Tom. The Amazon. Time-Life International, 1973. From Time-Life
Books” “The World’s Wild Places” series.

Wakefield, Celia. Searching for Isabel Godin. Chicago Review Press, 1994. A
travelogue that retraces the steps and recounts the incredible story of
Isabel Godin.

Historical Adventures

Here’s a list of books written by some of the characters who appear in
Amazon Trail II. Some of them are out-of-print but may be available at your
library. These books may be hard to find, but the search is worth it. If you
think Indiana Jones had some adventures in the Temple of Doom, wait "til
you read about Teddy Roosevelt on the River of Doubit!

Agassiz, Louis and Elizabeth. A Journey in Brazil. Fields, Osgood & Co.,
1869.

Bates, Henry Walter. The Naturalist on the River Amazons. Penguin Books,
1988.

Kreig, Margaret. Green Medicine. Rand McNally & Company, 1964.

Roosevelt, Theodore. Through the Brazilian Wilderness. Charles Scribner’s &
Sons, 1921.

Spruce, Richard. Notes of a Botanist on the Amazon. Edited by A. R. Wallace.
Macmillan and Co., 1908.

Wallace, Alfred Russel. Travels on the Amazon and Rio Negro. Ward, Lock &
Co., 1853.

Visit Our Web Site!

The MECC home page is your headquarters for access to information
about Amazon Trail Il and the real Amazon rainforest. Visit us at
http: /www.mecc.com.
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Credits

Product Development

Producer: Michael Palmquist
Product Director: Rich Bergeron

Design Team: Rich Bergeron, Devaun Ferguson, John Hickman,
Michael Palmquist, Dawn Wichmann, Sheila Kelly Zwettler

Story Designer and Script Writer: John Hickman

Art Team: Sheila Kelly Zwettler (Lead Artist), Clayton Black, John Diebel,
Laura Henion, Michele Johnson, Charolyn Kaplinger, Katie Kimrey,
Kristin Kuennen, Ed Madrid, Preston Palmer, Jan Tockman,

David L. Wood

Programming Team: Devaun Ferguson (Lead Programmer), Joan Clarke,
Susan M. Gabrys, Bob Gross, Al Lathrop, Brian S. Nesse,
Steven D. Splinter, Andrew W. Troelsen, Ju-Chang Wang, John P. Wlazlo

Guidebook Research and Writing: Rich Bergeron, Steven B. Cannon,
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Playtesters: Chase Johnson, Mikaila Johnson, Grace Robinson Leo,
Adam Lifto, Hilary Lundquist, Mitch Odell, Scott Ophoven,
Greg Swenson, Amanda Teigen

Video Production

Director: Richard D. Thompson

Producer: Michael Palmquist

Audio-Video Manager: Claudio E. Valenzuela

Costume Design/Production: Sonya Berlovitz, Debra Murphy
Production Stage Manager: Lesley Moore

Video Team: Tim Courteau, David Denninger, Cyndi Gamb]e,
Sara Ann Garvey, Juli M. Gustafson, Michele Johnson

Audio Team: Glen Anderson, Chad E. Iverson, Dan B. Otterdahl (Audio
Intern)

Costume/Makeup Artists: Tessie Bundick, Debra Murphy
Assistant to the Director: Rich Bergeron
Script Supervisor: John Hickman

Actors: See the About Amazon Trail command.

MECC Guarantee

For more than 20 years, MECC has been committed to serving children
and supporting the teachers and parents who shape their education. All
MECC software is designed to help children learn. We feel so strongly
about the educational value of our products that we guarantee it. If you are
not convinced that your kids are learning from MECC software, we'll
exchange your product or give you your money back. Simply contact our
Customer Service Department at 800/227-5609 and request a Return
Merchandise Authorization (RMA) Request number.
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MECC Technical Support

To enable MECC Technical Support to give you optimal service, please be
in front of your computer when you call or have the following information
available:

e the name, product number, and version number of the software;

e the brand and model of the equipment you are using;

* the specific details of where and how a problem occurred; and

e the exact wording of any error message you received.
If you are unable to reach us during business hours, please leave a
message with your daytime phone number and a technician will return

your call.

How to contact MECC Technical Support:

Telephone: 423/670-2036
Monday through Friday:
8:00 A.M. to 9:00 PM. Eastern Time
Saturday:
9:00 AM. to 7:00 PM. Eastern Time
Fax Machine: 423/670-2021
Electronically: America Online: keyword MECC
World Wide Web: http: /fwww.mecc.com/
E-mail: support@softkey.com
Mailing Address: SoftKey International Inc.
Attn: MECC Support Group
9715 Parkside Drive
Knoxville, TN 37922
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SoftKey License Agreement

This agreement governs your use of the SoftKey products enclosed with it including any
manuals, disks, computer program and materials associated with it (the “Software”). BY
OPENING THE SEALED PACKAGES CONTAINING THE DISKS AND/OR BY USING
THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN
THE DISK PACKAGES FOR A FULL REFUND TO THE PLACE WHERE YOU
PURCHASED THEM.

Grant of License. This Agreement permits you to use one copy of the Software, which is
licensed as a single product. The Software is “in use” on a computer when it is loaded into
the temporary memory (i.e., RAM) or installed into the permanent memory (e.g., hard disk
or other storage device) of that computer.You may use the Software on a network provided
you have purchased one copy for each user.

Copyright and Restrictions. The Software is owned by SoftKey or its suppliers and is
protected by United States and Canadian copyright laws and international treaty
provisions. SoftKey, its suppliers and licensors retains all rights not expressly granted. You
must treat the Software like any other copyrighted material, except that you may either
make one copy of the Software solely for backup or archival purposes or transfer the
Software to a single hard disk provided you keep the original solely for backup or archival
purposes. You may not rent or lease the Software, but you may transfer your rights under
this Agreement on a permanent basis provided you transfer the license granted by this
Agreement, the Software and all associated printed materials, retain no copies and the
recipient agrees to the terms of this Agreement. You may not reverse engineer, decompile
or disassemble the Software, except to the extent the foregoing restriction is expressly
prohibited by applicable law.

Limited Warranty. For 90 days from your date of purchase, SoftKey or its suppliers
warrants that the media on which the Software is distributed are free from defects in
materials and workmanship. SoftKey will, at its option, refund the amount you paid for
the Software or repair or replace the Software provided that (a) the defective Software is
returned to SoftKey or an authorized dealer within 90 days from the date of purchase and
(b) you have completed and returned the enclosed registration card. These are your sole
remedies for any breach of warranty. SoftKey, its suppliers and licensors disclaim all other
warranties, either express or implied, with respect to the Software and the accompanying
written materials, including but not limited to implied warranties of merchantability and
fitness for a particular purpose.

Limitation of Liabilities. In no event will SoftKey, its suppliers or licensors be liable for
any indirect, special, incidental, economic or consequential damages arising out of the use
or inability to use the Software, even if such party has been advised of the possibility of
such damages. In no event will SoftKey, its suppliers or licensors’ liability exceed the
amount paid by you for the Software. Because some jurisdictions do not allow the
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exclusion or limitation of liability for consequential or incidental damages, the above
limitation may not apply to you.

U.S. Government Restricted Rights. The Software is provided with RESTRICTED
RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer
Software—Restricted Rights at 48 CFR 52.227-19, as applicable. SoftKey International Inc.,
One Athenaeum Street, Cambridge, MA 02142,

IMPORTANT NOTE: In order to receive technical support and notification of product
upgrading and enhancements, please register this product.

Copyright Responsibilities

This software program contains copyrighted materials which are licensed to you for your
personal use, subject to the terms of the SoftKey License Agreement included with this
software package and the statement below entitled “Use of Animations, Photographs,
Images, Videos, Text, Music and Sounds.” It is illegal to duplicate or distribute any part of
this software program, except as stated in the SoftKey License Agreement and as detailed
below.

Use of Animations, Photographs, Images,
Videos, Text, Music and Sounds

Subject to the restrictions described below, you may use the Animations, Photographs,
Images, Videos, Text, Music and / or Sounds contained in this software product (the
"Content") for your personal use in connection with private presentations, private reports,
academic non-published reports, and other similar non-public uses. You may also publicly
display or demonstrate the software program in unaltered form on your computer.

1. You may NOT include the Content in any item that is offered for sale.
2. You may NOT modify or alter the Content in any way.

3. You may NOT incorporate the Content into any materials which are publicly
distributed or displayed, including any such advertisements, public
presentations (including public multimedia presentations), greeting cards,
invitations, announcements, calendars, catalogs, or other similar uses.

4.  Youmay NOT resell, sublicense or distribute the Program or any of the Content
in any electronic form, including on any on-line service or the Internet. For
example, you may NOT include Content in another software product for resale,
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or distribute the Content on any on-line bulletin board service or place the
Content on a Web page.

5. You may NOT use photos or images of people or identifiable entities in any
manner which suggests the endorsement or association of any product or
service or in connection with any pornographic or immoral materials.

6. You must credit the software program as follows: © 1996 SoftKey MultiMedia
Inc., a subsidiary of SoftKey International Inc., and its licensors.
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